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This Quick Reference Guide is designed to help the user to familiarize themselves with the equip-
ment, perform basic hardware setup/communications and operation. For detailed information

on both Hardware & Software components, please refer to the Help system accessible in the
M.O.L.E.® MAP Software.

To access the help system start the software and use any of the methods listed:

o Select the Help Button on the Toolbar.
* Pressing the shortcut key [F1] l
-
e Hep
¢ On the Help menu, click MAP Help. Koentaien

About MOLE i) MAP..

Augtharize



EQUIPMENT

Process and Ambient Sensors:
A combination of 3 thermal and
3 position sensors that measure

oven performance.

Zone Sensor Light:
This light illuminates when
the detects zone boundary

magnets.

Thermal Barrier:

This is the protective Ther-
mal Barrier for the M.O.L.E.®
Profiler.

___ Zone Sensor Battery:
This is the power source for the
zone sensor light.

Connector Bridge:
This is where the M.O.L.E.®
Profiler plugs into the RIDER.

Barrier Locking Latch: e
Secures the cover of the barrier
to prevent it from opening.

— Extractor Handle:
This disconnects the M.O.L.E.®
Profiler from the connector
bridge.



1. Insert the USB cable male series “A” plug
into a computer USB Port.

2. Insert the USB cable male series “B” mini
plug into the Data/Charging Port.

A completely discharged Power
Pack takes about 8 hours to be fully
o charged. For quick charges, it can be
charged for 15 minutes allowing one
10 minute data run to be performed.

.

CHARGING THE POWER PACK 0




SETUP CHARGING THE POWER PACK 6

1. Remove the Power Pack.

2. Plug the transformer end of the charger-
into a (120 or 230VAC) wall outlet and
the connector end into the Power Pack.

A completely discharged Power Pack
o takes about 14 hours to be fully

charged.

3. Once charged, reconnect to the
M.O.L.E.® Profiler. The activity light flash-
es once indicating the M.O.L.E.® Profiler
is ready to collect data.




1. Insert the Flash Drive in a USB Port and

the AutoPlay menu appears. AumprEIElg

2. Select Open folder to view files but-
ton on the AutoPlay menu to launch L ECD M.O.LE® MAP (E)
Windows® Explorer. Closely follow the
instructions for your operating system.
For detailed information view the Instal-
lation Help file on the Flash Drive.

General options

Open folder to view file
H h  using Windows Explorea‘h’]

View more AutoPlay options in Control Panel

SETUP SOFTWARE INSTALLATION e



SETUP SOFTWARE INSTALLATION o

The user must have administrator
permissions for the computer to in-
stall and register the software. To
install as administrator, locate the :
setup.exe on the installation drive. i e P38
Right-click the file to display the e

shortcut menu and select Run as ad-
ministrator.
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An Unlock Key can be obtained via an online
registration form or using the contact infor-
mation supplied on the dialog box, contact
ECD.

1. On the Help menu, click Register and the
dialog box appears.

2. Select Online Registration and enter the
required information on the M.O.L.E.®
MAP Software Registration form.

3. Enter the 16-digit Unlock Key and then
the Register command button to com-
plete the software Registration.

SETUP

MAP Registration (E3a)

Manual Registration

@ Use the Registration Number

Online Registration

below to obtain your Unlock Key.

Web: www.ecd.com/register
Email: register@ecd.com
Phone: +1 503 659 6100

Registration Number. 18978944

@ Unlock Key:

l

Help l ’ Ask Me Later l Register




SETUP COMMUNICATIONS 9

1. Plug the computer interface cable into a
computer COM Port and the other end
into the M.O.L.E.® Profiler Data Port.

When using a SuperM.O.L.E. Gold 2,
the AutoPlay panel appears in the

o lower right corner of the desktop.
This panel displays the four most
common MAP commands.

USB/RS-232
Adaptor

2. Onthe M.O.L.E.® menu, click the Select
Instrument command.

“B” mini plug I

“A” plug



3. Select the desired instrument from the EIMOLEMMAP V300 C:\Users\Documents\MOLE MAP\Basic Thermal Prof
dialog box. If there are none displayed, File Edit View Wizards Machine-Oven Assembly-Board
click the Scan for Instruments command Engineer im]l":mme":"'h ® alw|me

i . - up Instrument...
button to detect all available instru- Besic Pofing ‘3““_ IR T
ments. - Seect bstrument =

4. Click the OK command button to accept. e || | e sian o e

eh| .
.0 170.0f
Once a M.O.L.E.® Profiler has been se- % %
lected, the software automatically selects 122 @ ;
that M.O.L.E. Profiler if it used again on
the same COM port.




SETUP ZONE MAGNET INSTALLATION @

1. The zone boundary magnet kit is supplied with two  dif-
ferent types of magnet clips designed to mount the mag-
nets to the reflow oven rail. Reflow ovens may have differ- <
ent conveyor rails than the one used in these instructions, \
so determine which type will best mount the magnets in
your oven. Modifications to the clips may be necessary to
properly mount magnets.

2. Open the top of the oven and determine where to place the start of the first zone magnet.

3. Adjust the conveyor to match the RIDER width. (The width of the pallet is engraved on the
back edge of the pallet top.)

4. Slide the RIDER on the conveyor until the front sensor reaches the magnet.

5. Center a magnet and clip on the first zone boundary within 0.5” to 1.0” (1.3-2.5cm) from
the edge of the pallet and slide it past the magnet.



e When the RIDER front and rear zone sensors pass
the magnet, the Zone sensor light stay illuminat-
ed while each sensor has moved past it for .75”
+/-.25” (1.9cm +/- .6¢cm).

¢ When the RIDER passes the magnet, the Zone
sensor light must not double flash. If this occurs
the magnet is placed to close to the pallet
sensor.

6. When the magnet is properly aligned mount the
“P” clip securely by tapping and drilling for a #6
or #8 screw. If the “OMNI FLO” clip is being used,
clip it to the rail and slide it into the desired
position. Using the Manual Zone feature in the
software, you can make an oven model by mea-
suring from the magnet to the center between
zones for all the other zones.

ETUP




OPERATION INTRODUCTION @

This operation procedure guides you through a typical process on how to set a M.O.L.E.® Ther-
mal Profiler up for performing a OvenRIDER® NL 2+ data run. For additional detail, consult the
Help System in the software.

The M.O.L.E.® Thermal Profiler depends on the MAP (Machine-Assembly-Process) software to
control how it collects and interprets data. Several kinds of data runs may need to be performed
to achieve desired information, or the same data run may be performed repeatedly over time to
monitor one process. Either way, each data run must be set up at least once.

The MAP software includes wizards that help you get started quickly, even if you are a beginner
or infrequent user.



STEP 1: SETUP INSTRUMENT

1. Openthe M.O.L.E.® MAP software.

M.O.LE() MAPV3.00 C\Users\Documents\MOLE MAP\OvenRIDER Folder

2. Connect the M.O.L.E.® Thermal Profiler to the Fe_f Zm e M\[::a glh':;o;n ;Eh;;;;dgpgggrﬁ.
computer.
@ Basic Froing || | Select Environment Folder - OvenRIDER(H) (=5
3. Make sure the M.O.L.E.® Power Pack battery is fully -

C:\Usersimolf\Documents! e
C:\ECDWOLEMAP \Sample \sampleOvenRIDER

charged. When a M.O.L.E.® Thermal Profiler is se-

lected, the software status bar displays the current ounoR.
battery voltage. o]
4. Setan OvenRIDER® NL 2+ Environment. Either :

open an existing Environment Folder or create a PR
new one. New | erowse Remove from Ths List | ok |

AP Adaigelibausg |
4 [ » [\ Welcome! {Summary 4 Spreadsheet ), Profile {SPC /'

B} (422 B [76F/24C = @03 [M.O.LE. Profiler [ Read Instrume

OPERATIO UP INSTRUMEN




OPERATION SETUP INSTRUMENT @

When navigating through the wizard,
the step list on the left of the dialog
box uses a color key to inform the
user of the progression through the

o wizard.

[Icurrent

[ | Completed

| Remaining

5. Onthe M.O.L.E.® menu, select Setup Instrument
and the workflow wizard appears.

6. Setthe Instrument Name.

Sotup Instiiament
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For settings such as Start Parame-
o ters and Stop Parameters, select the

More>> command button.

7. Select the Sensor Platform button.

8. Select the OvenRIDER® NL 2+ then the OK com-
mand button to proceed.

9. Confirm the settings and then, select the
Next command button to send the data listed in
the dialog box to the instrument.

Sotup Instiiament
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OPERATION SETUP INSTRUMENT @
10. Confirm the assembly information.

11. Click the Next command button.

! v T ——
\% et Nursben: | OveniIDER
-

hee |

(Length:| 1780 () wadthi[ .80 Thckness: [0.0000  Units:fn -




12. Verify the instrument status. This dialog box
displays the health of the M.O.L.E.® Profiler such as @
battery charge, internal temperature, thermocou-

ple temperatures. Setup Inctiument . |
Hemary Avalabie: 93%
T Superd OLE. Gold 2 [ 1
If everything is OK, the dialog box dis- w . )|
plays a GREEN sign. If there are any N .
. B et Apsorsbly Infoomation T TaiOemaTest
items that may prevent the user from ) Vet binmrt Sen ne -nc gt
n
collecting good data, they are high- u< T.?g;?'“'“’]:‘““
lighted and a RED sign is displayed. TT:%M
Hssary BN
Farmmvang: 0.00
13. Select the Finish command button to complete the o v Eﬂ&:ﬁh
Setup Instrument wizard. : =
e [ oy ] |
e

OPERATION p INSTRUMENT ‘®



OPERATION DATA COLLECTION @

STEP 2: DATA COLLECTION

Never permit the M.O.L.E.® Thermal Pro-
filer to exceed the absolute maximum
warranteed internal temperature, as per-
manent damage may result. The warranty
will not cover damage caused by exceed-

ing the maximum specified internal tem-
perature.

1. Set the width of the conveyor to match the RIDER.

2. Set the oven as you normally would for a common
product (i.e. zone temperatures, conveyor speed).

3. Connect the M.O.L.E. Profiler to the connector
bridge in the Thermal Barrier. Turn it “ON” and
press the “RECORD” button.




4.

5.

Close the Thermal Barrier cover and latch
securely.

Place the RIDER on the reflow oven conveyor.
Make sure the RIDER is fed into the machine

in the proper direction. There are two arrows
on the RIDER barrier that indicates the prop-

er direction.

When the RIDER has traveled through the
oven, use protective gloves to retrieve it from
the conveyor. The best way to do so is to
grasp it by the front carrying handle.




OPERATION DATA COLLECTION @

It is important to open the Thermal Barrier
to prevent the internal temperature of the
M.O.L.E.® Profiler to rise above operating tem-
perature specification.

7. Open the Thermal Barrier and if the Record button is
still flashing this means the M.O.L.E.® Profiler is still
logging and it should be stopped.

8. Remove the M.O.L.E.® Profiler from the Thermal
Barrier by pulling the extractor handle up. Wait a few
minutes for the M.O.L.E.® Profiler to cool. Handle it
carefully, as the case may still be warm.

If the M.O.L.E.® Profiler is removed before it
o has stopped collecting data, it may cause the

data to become distorted.




STEP 3: DOWNLOAD DATA

1. Connect the M.O.L.E.® Thermal Profiler to a TrtoPley =
computer and the AutoPlay panel appears
in the lower right corner of the desktop. M.O.L.E: m

2. Select the Read Instrument command and the =/
workflow wizard appears. General Options

E Read Instrument...
Bl Dovrload most recent recorded data run

(RAA]
BAR ctart M.O.L.E.(r) MAP
;“3‘1 Start using M.0.L.E.{r) MAP Software

a7} Setup Instrument...
() SetaM.O.LE.(f) up to perform a data run

Instrument Status...
Wiew the status of the M.O.L.E.()

OPERATION DOWNLOAD DATA 2




OPERATION DOWNLOAD DATA @

3. Select the desired data run from the M.O.L.E.®
memory list and then click the Finish com-
mand button to complete the wizard and
read the data run from the M.O.L.E.® Profiler.

If a data run (*.XMG) is saved in a dif-
ferent Environment Folder other than
the currently selected, the software
automatically activates the new Envi-
ronment Folder. This process does not

o delete any data run files in the previ-
ously set Environment Folder and can
be quickly accessed using the Recent
Environment Folders on the File menu
or Welcome Worksheet.

My i plable: SR

e < prevews || | on | cned | |




4. When the data run has been downloaded, the
software will prompt the user to name and
save the data run file (*.XMG).

To prevent data loss, it is recom-
mended that data run files (*.XMG)
are not saved in the M.O.L.E. MAP
o Sample Environments. Your Environ-
ment Folders should be in locations
such as My Docs (Windows® XP) Li-

braries>Documents (Winows® 7/8).

5. The information is automatically saved in the
data run file (*.XMG) and the experiment data
can now be analyzed with the software tools.

OPERATION
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